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Preface

NOTICE TO CUSTOMERS

All documentation becomes dated, and this manual is no exception. Microchip tools and
documentation are constantly evolving to meet customer needs, so some actual dialogs
and/or tool descriptions may differ from those in this document. Please refer to our website
(www.microchip.com) to obtain the latest documentation available.

Documents are identified with a “DS” number. This number is located on the bottom of each
page, in front of the page number. The numbering convention for the DS number is
“DSXXXXXXXXA”, where “XXXXXXXX” is the document number and “A” is the revision level
of the document.

For the most up-to-date information on development tools, see the MPLAB® IDE online help.
Select the Help menu, and then Topics to open a list of available online help files.

INTRODUCTION

This chapter contains general information that will be useful to know before using the
dsPIC33CK Curiosity Development Board. ltems discussed in this chapter include:

* Document Layout

» Conventions Used in this Guide

* Recommended Reading

* The Microchip Website

» Product Change Notification Service

» Customer Support

* Document Revision History

DOCUMENT LAYOUT

This user’s guide provides an overview of the dsPIC33CK Curiosity Development
Board. The document is organized as follows:

» Chapter 1. “Overview” — This chapter introduces the dsPIC33CK Curiosity
Development Board and provides a brief overview of its various features.

» Chapter 2. “Hardware” — This chapter describes how to program/debug the
board using the on-board programmer and the main circuit elements of the board.

* Appendix A. “Board Layout and Schematics” — This appendix provides
schematic diagrams for the dsPIC33CK Curiosity Development Board.

+ Appendix B. “Bill of Materials (BOM)” — This appendix provides the component
list used in assembling the board.

© 2019 Microchip Technology Inc. DS50002859A-page 5


http://www.microchip.com

dsPIC33CK Curiosity Development Board User’s Guide

CONVENTIONS USED IN THIS GUIDE

This manual uses the following documentation conventions:

DOCUMENTATION CONVENTIONS

Description

| Represents

Examples

Arial font:

Italic characters

Referenced books

MPLAB® IDE User’s Guide

Emphasized text

...Is the only compiler...

Initial caps A window the Output window
A dialog the Settings dialog
A menu selection select Enable Programmer
Quotes A field name in a window or | “Save project before build”
dialog
Underlined, italic text with A menu path File>Save
right angle bracket
Bold characters A dialog button Click OK

A tab

Click the Power tab

N‘Rnnnn

A number in verilog format,
where N is the total number of
digits, R is the radix and n is a
digit.

4'b0010, 2'hF1

Text in angle brackets < >

A key on the keyboard

Press <Enter>, <F1>

Courier New font:

Plain Courier New

Sample source code

#define START

Filenames autoexec.bat

File paths c:\mcc18\h

Keywords _asm, _endasm, static
Command-line options -Opa+, -Opa-

Bit values 0, 1

Constants O0xFF, ‘A’

Italic Courier New

A variable argument

file.o,where file can be
any valid filename

Square brackets [ ]

Optional arguments

mccl8 [options] file

[options]

Curly brackets and pipe
character: { | }

Choice of mutually exclusive
arguments; an OR selection

errorlevel {01}

Ellipses...

Replaces repeated text

var name [,
var name...]

Represents code supplied by
user

void main (void)

{
}

DS50002859A-page 6
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RECOMMENDED READING

This user’s guide describes how to use the dsPIC33CK Curiosity Development Board.
The device-specific data sheets contain current information on programming the
specific microcontroller or Digital Signal Controller (DSC) devices. The following
Microchip documents are recommended as supplemental reference resources:

MPLAB® XC16 C Compiler User’s Guide (DS50002071)

This comprehensive guide describes the usage, operation and features of Microchip’s
MPLAB XC16 C compiler (formerly MPLAB C30) for use with 16-bit devices.

MPLAB® X IDE User’s Guide (DS50002027)

This document describes the installation and implementation of the MPLAB X IDE
software.

dsPIC33CK256MP508 Family Data Sheet (DS70005349)

Refer to this document for detailed information on the dsPIC33CK single core Digital
Signal Controllers (DSCs). Reference information found in this data sheet includes:

* Device memory maps

* Device pinout and packaging details

» Device electrical specifications

+ List of peripherals included on the devices

and are available for download from the Microchip website (www.microchip.com).

THE MICROCHIP WEBSITE

Microchip provides online support via our website at www.microchip.com. This website
is used as a means to make files and information easily available to customers.
Accessible by using your favorite Internet browser, the website contains the following
information:

* Product Support — Data sheets and errata, application notes and sample
programs, design resources, user’s guides and hardware support documents,
latest software releases and archived software

* General Technical Support — Frequently Asked Questions (FAQs), technical
support requests, online discussion groups, Microchip consultant program
member listing

» Business of Microchip — Product selector and ordering guides, latest Microchip
press releases, listing of seminars and events; and listings of Microchip sales
offices, distributors and factory representatives

PRODUCT CHANGE NOTIFICATION SERVICE

Microchip’s customer notification service helps keep customers current on Microchip
products. Subscribers will receive e-mail notification whenever there are changes,
updates, revisions or errata related to a specified product family or development tool of
interest.

To register, access the Microchip website at www.microchip.com, click on Product
Change Notification and follow the registration instructions.

© 2019 Microchip Technology Inc. DS50002859A-page 7
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CUSTOMER SUPPORT

Users of Microchip products can receive assistance through several channels:

« Distributor or Representative

* Local Sales Office

» Corporate Application Engineer (CAE)
+ Embedded Solutions Engineer (ESE)
* Field Application Engineer (FAE)

Customers should contact their distributor, representative or Embedded Solutions
Engineer (ESE) for support. Local sales offices are also available to help customers.
A listing of sales offices and locations is included in the back of this document.

Technical support is available through the website at:
http://www.microchip.com/support.

DOCUMENT REVISION HISTORY

Revision A (April 2019)
This is the initial release of this document.

DS50002859A-page 8 © 2019 Microchip Technology Inc.
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Chapter 1. Overview

1.1 INTRODUCTION

The dsPIC33CK Curiosity Development Board (DM330030) is intended as a
cost-effective development and demonstration platform for the dsPIC33CK256MP508
family of single core, high-performance Digital Signal Controllers (DSCs). The main
hardware features of the board are highlighted in Figure 1-1.

FIGURE 1-1: dsPIC33CK CURIOSITY DEVELOPMENT BOARD
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1. dsPIC33CK256MP508 single core, 16-bit Digital Signal Processor (DSP) target
device.

2. Integrated PICkit™ On-Board 4 (PKOB4) programmer/debugger.

2x mikroBUS™ interfaces for hardware expansion, compatible with a wide range
of existing click boards™ from MikroElektronika (www.mikroe.com).

1x Red/Green/Blue (RGB) LED.

2x general purpose orange indicator LEDs.
3x general purpose push buttons.

1x MCLR Reset push button.

10k potentiometer.

USB to UART interface.

0. Female, 100 mil pitch, 1/0 pin access headers for probing and connecting to all
target microcontroller GPIO pins.

w

S0 N O
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11. Configurable jumper (J11) for selecting +5V USB power or +5V external power.
12. Analog input section for dedicated ADC Core 0, Core 1 and shared core.

13. ADC reference generator MCP6021 op amp.

14. dsPIC33CK LDO.

Figure 1-2 and Figure 1-3 show the block diagrams of the dsPIC33CK Curiosity

Development Board and the PKOB main system. For more detailed schematics, refer
to Appendix A. “Board Layout and Schematics”.

DS50002859A-page 10
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FIGURE 1-2: dsPIC33CK CURIOSITY DEVELOPMENT BOARD BLOCK DIAGRAM
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Chapter 2. Hardware

21 POWERING THE BOARD
2141 USB Power

This board is intended to be primarily powered from the USB Micro-B connector, J7.
The official “USB 2.0 Specification” restricts USB applications to consuming no more
than 500 mA of USB VBUS power from the host.

21.2 External Power

An external +5 VDC may optionally be connected through the J2, J4 100 mil connector,
and the 2-pin jumper should be moved from +5V USB to +5V external power on the J11
3-pin connector.

An external +3.3 VDC may optionally be connected through the J1, J3 100 mil
connector to power an external circuit from the dsPIC33CK LDO. However, a maximum
of 50 mA consumption is recommended.

21.3 mikroBUS™ Power

An external +5 VDC may optionally be connected through the J2, J4 100 mil connector.
In this case, the 2-pin jumper should be moved from +5V USB to +5V external power
on the J11 3-pin connector. A maximum of 400 mA is recommended to be supplied to
the mikroBUS click boards™.

The mikroBUS +3.3 VDC power is connected to the +3V3PK on the PKOB4 LDO, which
can supply up to 500 mA.

2.2 USING THE PROGRAMMED DEMO FIRMWARE

The development board comes programmed with some basic demo firmware, which
exercises several of the board hardware features. The demo project for the dsPIC33CK
Curiosity Development Board implements an RGB color mixing application. In the
demo, the potentiometer can be used to adjust each color channel intensity
independently, while the push buttons are used to select the channel to be adjusted.

The source code for the demo can be obtained from:
www.microchip.com/dspic33ckcuriosity

2.3 REPROGRAMMING AND DEBUGGING THE dsPIC33CK256MP508 DEVICE

The board has a PICkit™ On-Board (PKOB) programmer/debugger circuit, which can
be used to program and debug the dsPIC33CK256MP508 target device (U1).
Alternatively, an external programmer/debugger tool can be connected to the board via
the 6-pin in-line connector J8, using a male-male 100 mil pitch 6-pin header.

© 2019 Microchip Technology Inc. DS50002859A-page 13
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FIGURE 2-1:

The PKOB circuit should automatically enumerate and be recognized by the
MPLAB® X IDE, v5.05 or later, when the dsPIC33CK Curiosity Board is connected to
the host via the USB Micro-B connector, J7. No custom USB driver installation is
necessary as the PKOB circuit relies on standard OS provided Human Interface Device
(HID) drivers, and therefore, the driver installation should be fully automatic. When
plugged in, the PKOB programmer/debugger tool can be selected from the MPLAB X
project properties page by selecting the device under: Hardware Tools>Microchip
Kits>Starter Kits (PKOB)>Curiosity/Starter Kits (PKOB4), as shown in Figure 2-1.

dsPIC33CK CURIOSITY PKOB TOOL SELECTION
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-0 ICD 4 (B3 15 (v1.34) [C:\Program Files (x86) Micr
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20 Snap
3 Alternate Tools
= |, Microchip Kits
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@ SKDE 33 ALDIO
- SKDE Memary
B

CVTE OIC19E

Manage Configurations...

*Tip: double dick on serial number (SM) to use a friendly name (FN) instead.

]| Cancel H Apply

Help

2.4

USING THE USB-UART INTERFACE

The board is equipped with a USB-UART interface based around the MCP2221A chip.
The MCP2221A chip implements the standard Communication Device Class (CDC) —
Abstract Control Model (ACM) protocol, and therefore, can use standard USB drivers
that are provided with modern Windows®, Mac® and Linux® operating systems. Under
most operating systems, the USB driver installation will be fully automatic. Under cer-
tain older operating systems, or if the device is attached to an older than Windows 10
machine without an active Internet connection, manual installation of the drivers may
be necessary. In this case, the driver package can be downloaded from:

www.microchip.com/mcp2221a
Details on how to access the serial port from Mac and Linux operating systems can also
be found in the associated collateral for the MCP2221A. Under Windows, after

successful USB driver installation, the device will appear as a “COMX” port object,
which standard serial terminal programs can open/read/write to and from.

DS50002859A-page 14
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2.5 CIRCUIT DETAILS

This section highlights some of the circuit elements and provides an explanation for
their intent and function.

251 Jumpers/Headers/Connectors

J1, J3 — These are populated 2x25-pin, 100 mil jumper headers, in which a power
module or any other custom designed board may optionally be inserted to access the
microcontroller’s digital pins. Use the triangle alignment mark on J1, pin 1 (underneath
VREF, see Figure 1-1) to connect the dsPIC33CK Curiosity Development Board to other
boards.

J2, J4 — These are populated 2x25-pin, 100 mil jumper headers, in which a power
module or any other custom designed board may optionally be inserted to access the
microcontroller’s analog and digital pins.

J5, J6 — These are female headers that implement the mikroBUS Interfaces A and B,
which are used to attach hardware daughter boards to expand the functionality of the
development board.

J7 — This is a standard female USB Micro-B connector, which connects to the
MCP2221A USB-UART converter chip and the on-board MPLAB PKOB4
programmer/debugger. This USB interface has a data interface and supplies power to
the rest of the board, as well as to the mikroBUS A and B, up to 400 mA.

J8 — This is an unpopulated 6-pin staggered header interface that can optionally be
used to connect an external programmer/debugger to the target microcontroller, U1.
The J8 header connects to the debug port, PGx3. The holes are slightly staggered,
which provides some friction retention force without requiring physical soldering when
a straight male-male or right-angle male-male header is installed into J8.

J9 —This is an unpopulated 2-pin, 100 mil jumper header, which may optionally be used
to insert a current meter in series with the U1 VDD current path to measure the
microcontroller’s current consumption. In order to measure the U1 current, the trace
(NT1) on the bottom of the PCB, that shorts the two pins of J1, should be cut and a
2-pin jumper should be soldered into J9.

J10, J12 — These are populated 2x2-pin, 100 mil jumper headers, which may optionally
be used to insert GND_D of a power module or any other custom designed boards that
access the microcontroller’s analog and digital pins. Also, it has the purpose of a
mechanical key that will prevent reverse connection.

25.2 User Interface (Ul)

The dsPIC33CK Curiosity Board contains a User Interface (Ul), easily accessible on
the right side (see Figure 1-1). The Ul has the following elements:

* One RGB LED

* A 10K Potentiometer

* Three Push Buttons

» Two Debug Orange LEDs

Each element can be programed for any purpose to create the desired interaction
between the user and the board behavior.

© 2019 Microchip Technology Inc. DS50002859A-page 15
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253 ADC Op Amp Analog RC Section

The board contains three RC filter components for each individual ADC core of the
microcontroller, U1. They are identical; the only difference is that one connects to the
dedicated ADC Core 1, another to the dedicated ADC Core 0 and the third one to the
shared ADC core.

The default configuration is the internal op amp variant, in which all passive
components, R and C, are populated for the filter, feedback and bias circuits.

To use the external op amp, remove R59, R75 and R81 resistors and populate C24,
C25 and C26 with 5600 pF, 50V, 0603, COG resistors to enable an RC filter of
Fc = 506 kHz.

There is an on-board MCP6021 op amp to power the internal VREF for the three
op amps with 1.65V (VDD/2) voltage reference.

VREF_EXT can also be used from connector J2 by removing, R30, 75 Ohm, and moving
it into the R31 place (default DNP).

The RC filters have a cutoff frequency:

EQUATION 2-1:

1
F. =
¢  2rnRC

where R is the resistance and C is the capacitor of the filter.

Example: R = 56 Ohms and C = 5600 pF, then Fc = 507509 [HZz] or 507 [kHZz].
Rise/fall time, with a steady state of 10% to 90%, is proportional to the time constant:
1 =RC.

EQUATION 2-2:

t. = 2.197t

For example: R = 56 Ohms and C = 5600 pF, then t, = 0.68 ps.

DS50002859A-page 16
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Appendix A. Board Layout and Schematics

This appendix contains the pinout, the schematics and the board layouts for the
dsPIC33CK Curiosity Board. The topics covered in this appendix include:

* Pinout

+ dsPIC33CK Curiosity Development Board Schematics
» dsPIC33CK Curiosity Development Board PCB Layout

A1  PINOUT
Table A-1 and Table A-2 show the pinout and the electrical parameters for connectors,
J1 and J2, respectively.
TABLE A-1: PINOUT AND ELECTRICAL PARAMETERS, J1
Name J1 dsPIC® DSC Pin Function/Description Remark

VREF_EXT 1 NC — —

+3.3V 2 12,31,51,71 |dsPIC DSC VDD Supply Output Limit 50 mA

NC 3 NC — —

GND_A 4 26 Analog Ground —
AN12_RP48 5 15 Analog Input —
IA_ANO_OA10UT 6 16 Analog Input, 56R, Cap = DNP | Fc = 507 kHz, t. = 0.68 ps
IB_AN1_OA20UT 7 41 Analog Input, 56R, Cap = DNP |Fc = 507 kHz, t, = 0.68 ys
S_ANA1_OAZ2IN- 8 18 Analog Input 2 kQ in series
S_AN8_OA2IN- 9 43 Analog Input 2 kQ in series
S_AN9_OA1IN+ 10 20 Analog Input 2 kQ in series

S _RB4_OA2IN+ 11 45 Analog Input 2 kQ in series
AN17_RP54 12 30 Analog Input —
AN2_CMP3A 13 58 Analog Input Comparator 3
IBUS_AN4_OA30UT 14 23 Analog Input, 56R Cap = DNP |Fc = 507 kHz, t, = 0.68 ps
AN10_PGD1 15 60 Analog Input —
S_AN13_OAS3IN- 16 28 Analog Input 2 kQ in series
AN15_CMP2A 17 33 Analog Input Comparator 2
S_AN14_OAS3IN+ 18 29 Analog Input 2 kQ in series
AN18_CMP3C 19 38 Analog Input Comparator 3
AN3_DACOUT1 20 21 Analog Input DAC output

AN20_REO 21 2 MikroA Analog Pin —
AN6_RP33 22 35 Analog Input —
AN22_RE2 23 17 MikroB Analog Pin —
AN11_PGCH1 24 61 MikroA Reset —
RP77_ANN2 25 14 Analog Input —
AN16_RP55 26 40 Temp. Input, RC Filtered FC=159 Hz, t,=2.1 ms
NC 27 NC Not Connected Reserved for future use
AN19_CMP2C 28 36 Analog Input Comparator 2

© 2019 Microchip Technology Inc.
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TABLE A-1: PINOUT AND ELECTRICAL PARAMETERS, J1 (CONTINUED)
Name J1 dsPIC® DSC Pin Function/Description Remark
NC 29 NC Not Connected Reserved for future use
AN21_RE1 30 4 VBUS Input, RC Filtered Fc=1.4kHz, t. =24 ps
NC 31 NC Not Connected Reserved for future use
AN23 RE3 32 19 Pot. Input, RC Filtered Fc=4.8kHz t, =72 ps
NC 33 — Not Connected Reserved for future use
NC 34 — Not Connected Reserved for future use
NC 35 — Not Connected Reserved for future use
NC 36 — Not Connected Reserved for future use
NC 37 — Not Connected Reserved for future use
NC 38 — Not Connected Reserved for future use
NC 39 — Not Connected Reserved for future use
NC 40 — Not Connected Reserved for future use
NC 41 — Not Connected Reserved for future use
ASCL1_RP57 42 47 mikroBUS™ [2C, SCL Parallel MikroA, MikroB
ASDA1_RP56 43 46 mikroBUS 12C, SDA Parallel MikroA, MikroB
NC 44 NC Not Connected Reserved for future use
NC 45 NC Not Connected Reserved for future use
SCL2_PGC3 46 56 Program/Debug PGC
SDA2_PGD3 47 55 Program/Debug PGD
MCLR 48 9 Device Reset OR series resistance
GND_D 49 11, 32, 50, 70 | Digital Ground —
GND_D 50 11, 32, 50, 70 | Digital Ground —
TABLE A-2: PINOUT AND ELECTRICAL PARAMETERS, J2
Name J2 dsPIC® DSC Pin Function/Description Remark
RP47_PWM1L 1 3 PWM Output 75R series resistance
RP46_PWM1H 2 1 PWM Output 75R series resistance
RP45_PWM2L 3 80 PWM Output 75R series resistance
RP44 PWM2H 4 78 PWM Output 75R series resistance
RP43 PWM3L 5 76 PWM Output 75R series resistance
RP42_PWM3H 6 75 PWM Output 75R series resistance
RP64_PWMA4L 7 74 PWM Output 75R series resistance
RP65 PWM4H 8 73 PWM Output 75R series resistance
RP53_PWM5L 9 65 PWM Output 75R series resistance
RP52_PWM5H 10 63 PWM Output 75R series resistance
RP63_PWM6L 1 8 PWM Output 75R series resistance
RP62_PWM6H 12 PWM Output 75R series resistance
RP59 PWM7L 13 67 PWM Output 75R series resistance
RP58 PWM7H 14 66 PWM Output 75R series resistance
RP61_PWMB8L 15 6 PWM Output 75R series resistance
RP60_PWM8H 16 5 PWM Output 75R series resistance
NC 17 — Not Connected Reserved for future use
NC 18 — Not Connected Reserved for future use
NC 19 — Not Connected Reserved for future use

DS50002859A-page 18
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TABLE A-2: PINOUT AND ELECTRICAL PARAMETERS, J2 (CONTINUED)
Name J2 dsPIC® DSC Pin Function/Description Remark
NC 20 — Not Connected Reserved for future use
NC 21 — Not Connected Reserved for future use
NC 22 — Not Connected Reserved for future use
NC 23 — Not Connected Reserved for future use
RE15_RGB_R 24 79 RGB LED Red —
RP79_RD15 25 10 MikroA UART RX —
RE14_RGB_G 26 77 RGB LED Green —
RP78_RD14 27 13 MikroA UART TX —
RE13_RGB_B 28 64 RGB LED Blue —
RP76_RD12 29 27 MikroB UART RX 100Q2 in series
RE12_MikroB_INT 30 62 MikroB Interrupt 1 kQ in series
RP73_RD9 31 48 MikroB UART TX —
RE11_MikroA_INT 32 59 MikroA Interrupt 1 kQ in series
RP72_RD8 33 49 mikroBUS™ SPI SCK Parallel MikroA, MikroB
RE10_MikroB_CS 34 57 MikroB CS Chip Select —
RP71_RD7 35 52 mikroBUS SPI MISO Parallel MikroA, MikroB
RE9_S3 36 44 User Switch S3 —
RP70_RD6 37 53 mikroBUS SPI MOSI Parallel MikroA, MikroB
RE8_S2 38 42 User Switch S2 —
RP69_RD5 39 54 Digital General Purpose —
RE7_S1 40 39 User Switch S1 —
RP68_RD4 UART_TX 41 68 UART Transmit MCP2221A —
RE6_LED1 42 37 Debug LED1 —
RP67_RD3 _UART_RX 43 69 UART Receive MCP2221A —
RE5_LED?2 44 24 Debug LED2 —
RP66_RD2_MikroA_CS 45 72 MikroA CS Chip Select —
RE4 46 22 MikroB Reset —
+5V_EXT 47 — Input External Power Selectable via J11
+5V_EXT 48 — Input External Power Selectable via J11
GND_D 49 11, 32, 50, 70 | Digital Ground —
GND_D 50 11, 32, 50, 70 | Digital Ground —

© 2019 Microchip Technology Inc.
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A.2 dsPIC33CK CURIOSITY DEVELOPMENT BOARD SCHEMATICS
Figure A-1 through Figure A-8 show the board schematics.

FIGURE A-1: dsPIC33CK CURIOSITY DEVELOPMENT BOARD SCHEMATICS, REV. 2.0 (PAGE 1 OF 8)
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FIGURE A-2:

dsPIC33CK CURIOSITY DEVELOPMENT BOARD SCHEMATICS, REV. 2.0 (PAGE 2 OF 8)
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FIGURE A-3:

dsPIC33CK CURIOSITY DEVELOPMENT BOARD SCHEMATICS, REV. 2.0 (PAGE 3 OF 8)
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FIGURE A-4:
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FIGURE A-5:

dsPIC33CK CURIOSITY DEVELOPMENT BOARD SCHEMATICS, REV. 2.0 (PAGE 5 OF 8)
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FIGURE A-6:
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FIGURE A-7:
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FIGURE A-8:
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dsPIC33CK CURIOSITY DEVELOPMENT BOARD PCB LAYOUT

The dsPIC33CK Curiosity Board is a four-layer FR4, 1.6 mm, Plated-Through-Hole (PTH) PCB
construction. Figure A-9 through Figure A-10 illustrate the PCB layers.

FIGURE A-9:

dsPIC33CK CURIOSITY DEVELOPMENT BOARD TOP SILKSCREEN AND TOP COPPER
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Board Layout and Schematics

FIGURE A-10:

BOTTOM COPPER
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dsPIC33CK CURIOSITY
DEVELOPMENT BOARD

MICROCHIP USER’S GUIDE

Appendix B. Bill of Materials (BOM)

This appendix contains the Bill of Materials (BOMs) for the dsPIC33CK Curiosity
Development Board.

+ Bill of Materials — dsPIC33CK Curiosity Development Board

B.1 BILL OF MATERIALS - dsPIC33CK CURIOSITY DEVELOPMENT BOARD
Table B-1 shows the Bill of Materials for the dsPIC33CK Curiosity Board.
TABLE B-1: dsPIC33CK CURIOSITY DEVELOPMENT BOARD BOM
. L. Manufacturer Part
Qty Designator Description_ Manufacturer Number
37 | C1, C1P, C2, C4P, Capacitor, Ceramic, 0.1 yF, Murata Electronics® GRM155R71C104KA88D
C5P, C6, C7,C7P, C8, |16V, 10%, X7R, SMD, 0402
C8P, C9, C9P, C10P,
C11, C12P, C14P,
C15P, C16P, C17P,
C18,C18P, C19, C19P,
C20P, C21,C21P, C22,
C22P, C23, C23P,
C28P, C29, C29P, C31,
C32, C33, C112
4 |C11P, C13P, C25P, Capacitor, Ceramic, 4.7 uF, TDK Corporation C1608X5R1C475K080AC
Cc27pP 16V, 10%, X5R, SMD, 0603
4 | C15, C26P, C34, C37 |Capacitor, Ceramic, 1000 pF, KEMET C0603C102M5RACTU
50V, 20%, X7R, SMD, 0603
5 |C2P, C10, C14, C20, Capacitor, Ceramic, 10 pyF, 10V, | Samsung Group CL10A106MP8NNNC
C42 20%, X5R, SMD, 0603
7 |C3,C4,C12,C13, Capacitor, Ceramic, 1 pyF, 16V, |Murata Electronics GRM155R61C105KEQ1D
C27,C28, C30 10%, X5R, SMD, 0402
2 | C39, C41 Capacitor, Ceramic, 18 pF, 50V, | Murata Electronics GRM1555C1H180JA01D
5%, COG, SMD, 0402
1 |C3P Capacitor, Ceramic, 0.022 yF, | Samsung Group CLO5B223KO5NNNC
16V, 10%, X7R, SMD, 0402
7 |C5, C16,C17, C35, Capacitor, Ceramic, 470 pF, Johanson Dielectrics 500R14W471KV4T
C36, C38, C40 50V, 10%, X7R, SMD, 0603
1 | D1 Diode, TVS Array, 82400152, | Wurth Elektronik 82400152
5V, USB 2.0, SMD, SOT-563
4 | D3P, LD1, LD2, LD3 Diode LED Green, 2V, 30 mA, | Lite-On®, Inc. LTST-C190KGKT
35 mcd, Clear, SMD, 0603
4 | D4P, LD4, LED1, LED2 | Diode LED Yellow, 2.1V, 20 mA, | Lite-On, Inc. LTST-C190YKT
6 mcd, Clear, SMD, 0603
2 |FB1,FB3 Ferrite, 600R at 100 MHz, 1A, |Bourns®, Inc. MH1608-601Y
SMD, 0603
2 |FB2P, FB3P Ferrite, 2A, 600R, SMD, 0805 | TDK Corporation MPZ20125601AT000
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TABLE B-1: dsPIC33CK CURIOSITY DEVELOPMENT BOARD BOM (CONTINUED)
. e Manufacturer Part
Qty Designator Description_ Manufacturer Number

4 |J1,J2,J3, J4 Connector, Header-2.54, 4UCON Technology Inc. {21382
Female, 2x25, Gold, 8.75 mm,
SMD, Vertical

2 [J10,J12 Connector, Header-2.54, 4UCON Technology Inc. {20943
Female, 2x2, Gold, 8.75 mm,
SMD, Vertical

1 [J11 Connector, Header-2.54, Male, | Harwin Plc. M20-8770342
1x3, Gold, 5.8 mm, SMD,
Vertical

4 |J5,J6 Socket, microBUS™, Host, Sullins Connector PPTCO081LFBN-RC
DIP, 16, TH Solutions

1 [J7 Connector, USB 2.0 Micro-B, FCI 10118194-0001LF
Female, TH/SMD, R/A

1 |LED3 Diode, LED Tri Red, Green, Cree, Inc. CLX6D-FKB-CMPQS-
Blue, 2.1V, 3.0V, 3.2V, 50 mA, GKBB7A363
35 mA, 35 mA, SMD, 6-PLCC

5 |R1, R2, R7P, R54, R55 | Resistor, TKF, 470R, 1%, Yageo Corporation RC0402FR-07470RL

1/16W, MF, 0402

SMD, 0603

3 |R10P, R27P, R58P Resistor, TKF, 47k, 5%, 1/10W, | Panasonic® - ECG ERJ-2GEJ473X
SMD, 0402
6 |R11, R53, R66, R80P, |Resistor, TKF, OR, 1/10W, Panasonic - ECG ERJ-3GSYOROOV
R81P, R86 SMD, 0603
6 |R11P, R12P, R13P, Resistor, TKF, 100k, 1%, Panasonic - ECG ERJ-2RKF1003X
R29P, R71, R72 1/10W, SMD, 0402
2 |R12,R18 Resistor, TKF, 100R, 1%, Panasonic - ECG ERJ-3EKF1000V
1/10W, SMD, 0603
5 |R13, R14, R15, R160, |Resistor, TKF, 330R, 1%, Panasonic - ECG ERJ-3EKF3300V
R161 1/10W, SMD, 0603
4 |R14P, R15P, R38P, Resistor, TKF, 4.7k, 1%, 1/16W, | Yageo Corporation RC0402FR-074K7L
R39P SMD, 0402
2 |R150, R151 Resistor, TKF, 15R, 1%, 1/16W, | Stackpole Electronics, RMCFO0603FT15R0
SMD, 0603 Inc.
1 |R157 Resistor, TKF, 1M, 1%, 1/10W, | Panasonic - ECG ERJ-3EKF1004V
SMD, 0603
9 |R16, R17P, R18P, Resistor, TKF, 330R, 1%, Yageo Corporation RC0402FR-07330RL
R19P, R30P, R34P, 1/16W, SMD, 0402
R35P, R36P, R37P
1 |R17 Resistor, Variable, 10K, 20%, TT Electronics Plc. P090S-14T20BR10K
TH, P090S
10 |R1P, R2P, R8P, R25P, |Resistor, TKF, 10k, 1%, 1/10W, | Panasonic - ECG ERJ-2RKF1002X
R27, R28, R29, R31P, | SMD, 0402
R70, R159
20 |R20, R21, R30, R36, Resistor, TKF, 75R, 1%, 1/16W, | Yageo Corporation RC0402FR-0775RL
R37, R38, R39, R40, SMD, 0402
R41, R42, R43, R44,
R45, R46, R47, R48,
R49, R50, R51, R52
3 |R24, R25, R26 Resistor, TKF, 56R, 1%, 1/10W, | Panasonic - ECG ERJ-3EKF56R0V
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TABLE B-1:

dsPIC33CK CURIOSITY DEVELOPMENT BOARD BOM (CONTINUED)

Qty Designator

Description_

Manufacturer

Manufacturer Part
Number

5 |R28P,R32, R32P, R33,
R33P

Resistor, TKF, 3.3k, 1%, 1/10W,
SMD, 0402

Panasonic® - ECG

ERJ-2RKF3301X

5 |R3, R5, R7,R9, R19

Resistor, TKF, 10k, 1%, 1/10W,
SMD, 0603

Panasonic - ECG

ERJ-3EKF1002V

R42P, R60, R61, R62,
R63, R76, R77, R78,
R79, R82, R83, R84,

SMD, 0603

1 |R3P Resistor, TKF, 442k, 1%, Samsung Group RC1005F4423CS
1/16W, SMD, 0402
18 | R4, R6, R8, R34, R35, |Resistor, TKF, 1k, 1%, 1/10W, |Panasonic - ECG ERJ-3EKF1001V

Single, 12.000 MHz,
DSC6011J11A-012.0000, VLGA

Inc.

R85

2 |R40P, R41P Resistor, TKF, 22 Ohm, 1%, Yageo Corporation RCO0603FR-0722RL
1/10W, SMD, 0603

1 |R4P Resistor, TKF, 95.3k, 1%, ROHM Semiconductor | MCRO1MRTF9532
1/16W, SMD, 0402

6 |R58, R59, R74, R75, |Resistor, TKF, 30k, 1%, 1/10W, | Stackpole Electronics, RMCF0603FT30K0

R80, R81 SMD, 0603 Inc.

1 |R5P Resistor, TKF, 24.3k, 1%, Samsung Group RC1005F2432CS
1/16W, SMD, 0402

3 |R67, R68, R69 Resistor, TKF, 56k, 1%, 1/16W, | ROHM Semiconductor | MCRO1MZPF5602
SMD 0402

2 |R6P, R16P Resistor TKF, 5.62k, 1%, Vishay Intertechnology, | CRCW04025K62FKED
1/16W, SMD, 0402 Inc.

2 |R9P, R57P Resistor, TKF, 31.6k, 1%, Panasonic - ECG ERJ-2RKF3162X
1/10W, SMD, 0402

4 |S1,S2,S3, 54 Switch. Tact., SPST, 12V, 50 mA, | Wurth Elektronik 430182043816
PTS645SM43SMTR92, LFS,
SMD

1 |U3P IC, Switch, SPDT, Texas Instruments SN74LVC1G3157DCKR
74LVC1G3157, SC-70-6

3 |U6BP, U7P, USP IC Transceiver, NXP Semiconductors 74LVC1T45GW,125
74LVC1T45GW, Single Bit
Voltage Translator, SOT-363

1 Y2 Crystal, 24 MHz, 6 pF, SMD, Murata Electronics® XRCGB24MO0OOFOLOORO
L2.0W1.6H0.7

1 |U2 Microchip Analog LDO, 3.3V, Microchip Technology MCP1755T-3302E/OT
MCP1755T-3302E/OT, Inc.
SOT-23-5

1 |U5P Microchip Analog LDO, 3.3V, Microchip Technology MCP1727T-3302E/MF
MCP1727T-3302E/MF, DFN-8 | Inc.

1 |U3 Microchip Analog Op Amp, Microchip Technology MCP6021T-E/OT
1-Ch, 10 MHz, Inc.
MCP6021T-E/OT, SOT-23-5

1 |U1P Microchip Analog Power Microchip Technology MIC2042-1YTS
Switch, 5.5V, 3A, Inc.
MIC2042-1YTS, TSSOP-14

1 |Y1P Microchip Clock Oscillator, Microchip Technology DSC6011J11A-012.0000
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TABLE B-1:

dsPIC33CK CURIOSITY DEVELOPMENT BOARD BOM (CONTINUED)

Qty Designator

Description_

Manufacturer

Manufacturer Part
Number

1 |X1

Microchip Clock Oscillator,
Single, 8.000 MHz,
DSC6011J11A-008.0000,
VDFN-4

Microchip Technology
Inc.

DSC6011J11A-008.0000

1 |U60

Microchip Interface USB 2.0,
High Speed, 2 Port HUB
Controller, QFN-24

Microchip Technology
Inc.

uUSB2422T-I/MJ

Microchip Interface, USB,
I2C/UART, MCP2221A-I/ML,
QFN-16

Microchip Technology
Inc.

MCP2221A-I/ML

Microchip MCU, 16-Bit,

256 Kbyte Flash, 24 Kbyte,
dsPIC33CK256MP508-I/PT,
TQFP-80

Microchip Technology
Inc.

dsPIC33CK256MP508 I/PT

1 |U2P

Microchip MCU, 32-Bit,

300 MHz, 2 Mbyte, 384 Kbyte,
ATSAME70N21B-ANT,
LQFP-100

Microchip Technology
Inc.

ATSAME70N21B-ANT

1 |U4P

Microchip Memory Serial
EEPROM, 256k, I12C,
24| C256T-E/ST, TSSOP-8

Microchip Technology
Inc.

241L.C256T-E/ST
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